
Negative: Only the negative data points are included in the calculation.

Data points with values above zero make the Integral larger, those with values less than zero 
make the Integral smaller. To successfully complete the calculation of the Integral, the location 
of the zero-line needs to be known. 

Setting the baseline of the raw data channel to zero is the more important of the two require-
ments since this function defines the difference between positive and negative areas of the 
recording. If the baseline of the raw data record is in the positive range of amplitudes, then the 
Integral will have a positive slope, even though no signal is present. Conversely, if the baseline 
of the raw data is in the negative range, the Integral will have a negative slope.

Zero As mentioned above, the Integral function adds the amplitudes of successive data points and 
plots the total. The problem is determining where the zero-line is located. DataTrax2 and most 
other data programs take the value zero volts as the zero-line. If real units, such as grams or 
mmHg are used, the DataTrax2 software will take the zero units value as zero. 

DataTrax2 also has a Use First “Number” seconds as zero option. The data values for the 
first “Number” of seconds collected are averaged and used by the program as zero. This 
feature is particularly useful when trying to integrate signals that are difficult to zero manually. 

An example of the application of this feature is illustrated in Figure 5-2 on page 47. The output 
of a respiratory flow sensor is the raw data displayed on the upper channel in each window; the 
lower channel in each window is the integral of the upper channel, or the volume flowing through 
the sensor. 

In this example, the setting of zero is critical because any offset of the raw data from zero will 
be taken as a flow and, subsequently, be interpreted as a volume. Two examples of the respi-
ratory integral are shown. In each case the flow sensor has a small, but stable offset. In the first 
example, the integral shows constant increase in volume, even as the flow is constant. In the 
second record, where the Use First “Number” seconds as zero option is used, the initial flow 
is constant and is set to zero, so the initial volume is zero. When the flow increases to a level 
above the “effective” zero-line, then the volume will increase on the integral channel. 

 Figure 5-2: Integral without Zero.
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Also enter this X value in the text box below the graph. Clicking the Calibrate Difference 
between Cursors button will calculate the required calibration value and place it in the 
Spirometer Calibration window. 

To account for offset in the spirometer, choose a time at the beginning of the record when 
there is no flow through the spirometer and enter this value in the Use First N Seconds as Zero 
text box. DataTrax2 will take the first N seconds, average them together and use the result to 
set the zero-line of the Volume channel. This is necessary because the output of the air flow 
sensor is always offset and any offset causes the Volume channel to display a volume change, 
even though no air is flowing through the sensor.

The Volume integral can also be set to reset after a certain time or with every cycle. During 
spirometry experiments, the volume trace drifts upward because the volume of exhaled air is 
larger than the volume of inhaled air. Cooler inhaled air at room temperature occupies less 
volume than warmer exhaled air. The Volume integral will drift up and out of view, as it reports 
correct values, unless a periodic reset is employed. 

Activating 
Spirometry 
Function

To apply the Spirometry function to a channel, click on the Add Function button in the 
Channel bar. Select Spirometry from the Function menu.

Channel 
Math

The Channel Math function applies a user-defined function to points from up to four data 
channels and displays the output in a computed channel. There are four Variables A, B, C and 
D, each of which can be associated with a user selectable data channel. For example, if you 
wanted to divide Channel 1 by Channel 2. Click on the Add Function button on either the 
Channel 1 or Channel 2 channel bar. Select the Channel Math option. Select A to be Channel 1, 
and B to be Channel 2. Set the channel value to be A/B.

 Figure 5-4: The Channel Math dialog window. eg, output channel is equal to (RawCh 1 plus Raw Ch 2 / 2) * Comp Ch 1 in grams

The result is every Channel 1 data point divided by the corresponding Channel 2 data point. A 
full range of trig and log functions, as well as the common mathematical operators, are 
available in the Channel Math dialog window. The Unit Name for the calculated value can be 
specified in a box. There is also a Check Expression feature, which will check for errors like 
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unclosed parentheses or division by zero. Since division by zero is a possible occurrence even 
in legitimate expressions, but it cannot be calculated by a computer, the program substitutes the 
last calculated value for the quotient if division by zero is attempted.

Activating 
Channel Math

To apply the Channel Math function to a channel, click on the Add Function button in the 
Channel bar. Select Channel Math from the Function menu. Select the channels corre-
sponding to A, B, C and D. Program the expression desired. Set units if desired, and click OK.

Filter Each channel has its own digital filter that can be used on-line or off-line. DataTrax2 uses a 
FIR (Finite Impulse Response) filter. There are various windowing functions that can be used 
for setting up an FIR filter. The Hamming window (default) is appropriate for most applications. 
In addition to this windowing function DataTrax2 also provides Rectangular, Bartlett, Hanning, 
Blackman and Blackman-Harris windowing functions. The filter order is the number of data 
points in the raw data required to calculate each point in the filtered data. The strength of the 
filter is determined by the filter order. The higher the order, the stronger the filter. Note that the 
higher the order the longer it takes to calculate, which can slow down the display. Also the first 
and last order/2 data points in the filtered data are invalid. For example, if the filter order is 51, 
then the first 25 and the last 25 data points in the filtered data are invalid. 

 Figure 5-5: The digital (software) Filter dialog window.

In the Filter Setup dialog, drag the boundaries of the filter or enter the values in the Low 
Cutoff and the High Cutoff fields to create the desired filter. The graphic interface in the Filter 
Setup dialog is straight forward. The colored area corresponds to the frequencies that are 
passed, and the white area corresponds to the frequencies that are rejected. To remove high 
frequencies from the signal, click on the right boundary of the colored area and drag this 
boundary to the left. To remove low frequencies from the signal, click on the left boundary of the 
blue area and drag this boundary to the right. After clicking and dragging a boundary, it can be 
placed more accurately by entering the values in the Low Cutoff and High Cutoff fields. Bound-
aries can be placed in configurations that create High Pass, Low Pass, Band Pass (as shown 
in Figure 5-5 on page 50), or Notch filters.
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Notice that the filter is subject to the Nyquist limitation of frequency. The maximum frequency 
in the Filter Setup dialog is exactly half of the sample frequency.

Smoothing All experimental data includes noise to varying degrees. Noise can obscure important features 
like peaks, valleys, or peak widths. DataTrax2 allows you to smooth noisy signals to reveal 
significant features of your data. In addition to filters, DataTrax2 also offers the ability to smooth 
the data. Smoothing is used to remove noise that is uniform across all frequencies. Each 
method offers different performance to best show significant aspects of your results. Filtering 
allows you to eliminate noise above a specified frequency. DataTrax2 provides two kinds of 
smoothing; Moving Average does wide smoothing, while Savitzky-Golay seeks to preserve 
shapes of peaks.

Moving Average: Applies a user specified number of points on either side of each data point 
to calculate the mean and replaces the datapoint with the calculated mean. For example, if you 
set the number of data points on either side to 1, then 

new data (N) = {data(N-1) + data(N) + data(N+1)}/ 3

Savitsky-Golay: The Savitzky-Golay method essentially performs a local polynomial 
regression to determine the smoothed value for each data point. This method is superior to 
Moving Average because it tends to preserve features of the data such as peak height and 
width, which are usually 'washed out' by adjacent averaging. To use the Savitsky-Golay 
smoothing type, the order of the polynomial and the number of points on each side of the data 
need to be specified.

In addition to smoothing the data, DataTrax2 also provides the option to calculate the 
smoothed 1st, 2nd or 3rd derivative of the data. 

Power The Power function performs a Fast Fourier Transform (FFT) on data in the selected channel 
and returns the average Power in the frequency band selected. 

 Figure 5-6: The Power dialog window.

In DataTrax2, this function works only off-line. The graphic interface in the Power dialog 
window is similar to the one in the Filter Setup dialog. The band of frequencies selected from 
the Power dialog window are not filtered, but they are subjected to an FFT whose output is 
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known as a Power Number. In addition to specifying the range of frequencies transformed, the 
frequency resolution can be selected. The higher the frequency resolution, the more data points 
required to compute the FFT. Therefore, at slow sampling rates, higher frequency resolutions 
may require the processing of more data points from longer recording periods. 

Cardiac The Cardiac functions are specifically used for the analysis of electrocardiograms (ECG). 
Four of the Cardiac functions calculate Leads: III, aVL, aVF and aVR from the recordings of 
Lead I and Lead II. 

You can specify which channel corresponds to Lead I 
and Lead II in the Cardiac Setup dialog. DataTrax2 
can be programmed to do these calculations because 
all the points of view in a 6-lead ECG are in the same 
plane (frontal) of the body and each lead can be 
considered as a vector. So if any two of the limb leads 
are recorded, the other four leads can be calculated 
from them. 

The Cardiac submenu also includes other functions. The Cardiac 
Angle function calculates the vector of the cardiac depolarization 
that passes through the interventricular septum. Three Power 
functions, which are special cases of the general power function 
described earlier, are also available. These three power functions 
are useful for heart rate variability (HRV) analysis. Low Frequency 
(LF) Power (0.04-0.15 Hz), High Frequency (HF) Power (0.18-0.4 
Hz) and Total Power are each calculated from the transformation of 
a tachogram of an ECG on one of the raw data channels. The HRV 
Ratio which is (Low Frequency (LF) Power)/High Frequency (HF) 
Power is also available.

Activating Cardiac 
Functions

To apply the Cardiac function to a channel, click on the Add Function button in the Channel 
bar. Select Cardiac from the Function menu, then select the appropriate submenu. Select the 
channels corresponding to Lead I and Lead II and click OK

EEG The EEG function is another specialized case. 
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In this function, a preset frequency band is available for each 
component of the EEG: Alpha, Beta, Theta, Delta, Betalow, Beta Mid 
and Beta High. For each selected band, DataTrax2 can also calculate 
the average power in the band and display the value against time. 
These are beneficial functions to use when teaching students, because 
they can clearly see the effect that behavior has on components of the 
EEG.

Activating EEG 
Functions

To apply the EEG function to a channel, click on the Add Function button in the Channel bar. 
Select EEG from the Function menu, then select the appropriate submenu and click OK.

Gain 
Telegraph

The Gain Telegraph function is slightly 
different from the other functions. Some ampli-
fiers have an additional output that sends a 
calibration signal to the data recording unit. 
This calibration signal relays information about 
the gain settings of the external amplifier. This 
information permits the recording program to 
re-calibrate the amplifier output in the correct 
units regardless of the gain set on the 
amplifier. 

Using Gain 
Telegraph

Connect the analog output of the supported amplifier to any input channel. For this example, 
assume this is Channel 1. Next, connect the gain telegraph output of the amplifier to any input 
channel. For this example, assume this is Channel 2. 

To apply the Gain Telegraph function to a channel, click on the Add Function button in the 
Channel bar. Select Gain Telegraph from the Function menu. Select the manufacturer of your 
amplifier, then select the amplifier you are using. Select the channel that the output from your 
amplifier is connected to (Channel 1 in this case), then select the Gain Telegraph Channel 
(Channel 2 in this case) and click OK.
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Digital Input The Digital Input function treats the data on the 
selected channel as a binary number.

The functions in the Digital Input submenu are:

Raw: The digital value as a 32 bit word is 
displayed

Frequency: The program takes the period in 
seconds and divides this value into 1. The result 
is a frequency, which is expressed in Hz or 

cycles per second.

Period: The program takes the period for each cycle.

Time On: The time that the selected channels are high.

Time Off: The time that the selected channels are low.

Duty Cycle: 100* (Time On)/Period.

Count: Number of events.

The channels of interest can be 
selected using the checkboxes. If 
you desire to complement the input 
before it is used then click on the 
checkbox again, as shown in the 
legend.

Reset After n sec: This option is 
only available for the Count 
subfunction, which is used to reset 
the count after n seconds.

Any Bit is Set/ All Bits are set: 
Choose if you want an event to be 
detected if any channel is high or if 
you only want an event to be 
detected if all channels are high.
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CrossTime 
Channel 
Calculation

Initial Delay: The amount of time from the start of recording until the function is initiated.

Selection Duration: Period of the protocol.

To setup CrosstimeChannelCalculation, you need to setup the Initial Delay before the 
function is initiated and set the Selection Duration to the period of the protocol. Selection can 
be set to start when the data on a selected channel goes above an operator selected value.

For each selection as defined above, variable A can be setup to equal the mean, maximum, or 
minimum of the data between the selected time range on a selected channel. Variables B,C and 
D can be setup in similar fashion.

The title and units name of the computed channel can be set. The variables A,B,C,D and the 
calculator can be used to create an equation for the computed channel.
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MultiPoint 
Calibration

MultiPoint Calibration can be used to perform a linear and non-linear calibration of sensors, 
transducers, amplifiers and other equipment. It can also be used to check if an existing sensor 
is linear.
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Template 
Match

Template Matching is a technique in digital signal processing for finding small parts of a 
signal which match a template. The idea of template matching is to create a model of a signal of 
interest (the template, or kernel) and then to search over the recorded data for objects that 
match the template. To create a template, select a region of interest using the two cursors. Click 
Create Template from data between cursors to create a baseline for the template. For each 
point in the template, you can set the acceptable tolerance. The tolerance can be fixed for all 
points or variable. In case of variable tolerance, you set the high and the low limits of the 
tolerance separately. You can move the complete line up/down using Block Move Cursor, or 
you can move only certain segments of the curve using freehand Move using. When using the 
freehand move, you also have to specify the number of points each move will influence. 

Once a template is created, the program will find segments of the data where each datapoint 
in the segment matches the template within the tolerance for each point. 
5 Analysis 57



. .
 

Auto 
Correlation

Correlation is the mutual relationship between two or more random variables (Ali). AutoCorre-
lation is the correlation of a signal with itself (Parr 1999). AutoCorrelation is a mathematical tool 
used frequently in signal processing for analyzing functions or series of values, such as time 
domain signals. Informally, it is a measure of how well a signal matches a time-shifted version of 
itself, as a function of the amount of time shift. More precisely, it is the cross-correlation of a 
signal with itself. AutoCorrelation is useful for finding repeating patterns in a signal, such as 
determining the presence of a periodic signal which has been buried under noise, or identifying 
the missing fundamental frequency in a signal implied by its harmonic frequencies.(Wikipedia 
2007). 
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Analyses of the Second Kind: Digested Data

The functions in this kind of analysis take a group of data points selected by the user and 
"digests" them into a single value. These values can be saved to the Journal within DataTrax2 
or exported to other programs. This kind of analysis can proceed in the Analysis window. There 
are currently 24 functions available in the DataTrax2 program to do this kind of analysis. Some 
of the functions are: Mean, Max, or Max-Min.

Analysis 
Window 
Setup

The Analysis window (see Figure 5-7 on page 60) is used to display and perform calculations 
on selected pieces of data or sweeps captured from the Main window. The data used in the 
Analysis window is defined by the data displayed in the Main window. The data is then captured 
by either clicking the Analysis icon on the DataTrax2 toolbar or selecting Analysis from the 
Windows menu. Data from all channels within the selected area are displayed in the Analysis 
window. 

Many of the same tools in the Main window are also available in the Analysis window. These 
include: Display Time controls; Marks, which are the same as the ones positioned in the Main 
window; and 2 Cursor mode (Single Cursor mode is unavailable). Scroll bars can be used to 
fine tune the area of data upon which the selected functions will operate in Chart mode. In 
Scope mode the sweeps of interest can be selected Individually or as part of a group. 

Data in the Analysis window can be operated upon by the functions selected with the Add 
Function button just above the left hand side of the first channel. Functions are organized in 
three groups: General, Derivative and Integral (Area). To add a function click on the Add 
Function button, choose the Function Group and then the desired function from the submenu. 
The selected function will now appear to the left of the Add Function button. 

Again, the 2 Cursors are positioned on the left and right edges of the data to be analyzed. 
DataTrax2 will immediately calculate and display the values for the selected parameters in the 
Channel Bar of each channel. The precision of the calculations performed is adjustable using 
the Data Display Precision value in the Options page of the Preferences window. 

There are 24 analytical functions available in the Functions list. These functions are 
described below. The values listed in the Channel Bar area can be sent to the Journal for 
formatting and inclusion in reports. To do this, click on the Channel menu (or right-click in the 
channel area) and select Add Ch. Data to Journal, Add Title to Journal or Add All Data to 
Journal. 

Add Ch. Data to Journal: Adds data from the selected channel to the Journal.

Add All Data to Journal: Adds data from all channels to the Journal.

Add Title to Journal: Adds the function titles to the Journal.

The Analysis window can also be copied, printed, or exported to ASCII, .png, or .bmp format 
documents.
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 Figure 5-7: The DataTrax2 Analysis window.

Analysis 
Window 
Components

Functions List The functions selected in the Add Functions list determine the calculations performed on the 
data points between the two cursors in the Analysis window. The results of the selected calcu-
lations are displayed in the Channel bar area at the top of the each Channel .

Tiled or Stacked 
Display

By default, the channels selected for display are presented in Tiled 
mode. Each channel is displayed in its own area, as they are shown 
in the Main window. By clicking the Stacked/Tiled icon in the lower 
left hand corner of the Analysis window, selected waveforms can be 
overlaid on the same set of axes.
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Channel Menu in 
the Analysis 
Window

Clicking on the Channel Menu button or 
right-clicking in the display area of the 
Analysis window brings up the Channel 
menu. 

Add Ch. Data to Journal: Adds data 
from the selected channel to the 
Journal.

Add All Data to Journal: Adds data 
from all channels to the Journal.

Add Title to Journal: Adds the function 
titles to the Journal.

Calculations: Brings up the calculations 
submenu, for performing dedicated 
calculations in Spirometry, ECG, Blood 
Pressure and Peak Analysis. This is 
discussed later in this chapter

Copy Graph: Copies the channel graph 
to the clipboard, This can be then 
pasted into the Journal or any other 
program.

The remaining functions operate in the same manner as in the Main window

Scope Mode 
Display 
Options

In Scope mode, you can view multiple sweeps at the same 
time. Sweeps can be selected and deselected from the 
Sweep Selection bar. Data can be calculated from only one 
sweep at a time. The primary sweep, on which the functions 
operate, is selected in the drop-down box to the left of the 

Add Function bar. The primary sweep cannot be deselected from the Sweep Selection bar.

To manage several sweeps, DataTrax2 provides a Sweeps Manager. The Sweeps Manager is 
available from the Sweep menu button to the left of the Sweep Selection bar. In the Sweep 
Manager, one can organize the sweeps into groups. To create a group, click on the Create New 
Group button and the Edit Group Name dialog will appear. Enter a name for the new group and 
click OK. The group is now listed in the group tree. To add a sweep to a group, select a sweep 
from the available sweeps list and drag it to the group, or click the Add button. To remove a 
sweep from a group, select the sweep and click the Remove button.

To switch the display from Sweep mode to Group mode, click on the Sweep/Group mode 
button to the left of the scrollbar. This button changes between Sweep and Group mode. 

Table 
Functions 

These functions are available in the Analysis window.

General Value1: Value at Cursor 1

Value2: Value at Cursor 2

Time1: Time at Cursor 1

Time2: Time at Cursor 2
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V2-V1: Value2-Value1, i.e. the difference in value between the cursors

T2-T1: Time2-Time1, i.e. the difference in time between the cursors

Max: Maximum value between the cursors

Min: Minimum value between the cursors

Mean: Mean or Average value between the cursors.

Max-Min: Difference between the maximum and minimum values between the cursors.

Mark: Text of a mark between the cursors

Unit: The units of the channel

RMS: Root Mean Square of the values between the cursors

StdDev: Standard Deviation of the values between the cursors

Count of Events: Number of events between the cursors.

Derivative dV1/dt:Derivative at Cursor 1

dV2/dt:Derivative at Cursor 2

Max dV/dt: Largest dv/dt values for all of the data points between the two cursors.

Min dV/dt: Smallest dv/dt values for all of the data points between the two cursors.

Mean dV/dt: Mean dv/dt for all of the data points between the two cursors. This is also the 
slope of the line of best fit for all the data points between the cursors.

Integral All the integral and area functions are calculated as integrals. 

Area: The Area function uses the line between V1 and V2 as the zero baseline, and then 
calculates the integral.The Area function gives more control over which segments of a waveform 
are included in the integral. 

Abs. Area: The absolute value of each data point is used to calculate the area as described 
above. Areas that would have been subtracted in the Area function, are instead added in the 
calculation of the Absolute Area. 

Int: For the Integral calculation, zero volts (or zero calculated Y-value) is used as the zero 
reference for the integral. Values above zero add to the Integral and values below the zero-line 
subtract from the Integral.

Abs Int: The Absolute Integral is very much like the Integral, except that the program takes 
the absolute value of the raw data before performing the integral operation.

Calculations All calculations have a similar dialog, there is a picture at the top, which shows some sample 
data and where to place the cursors. You can choose the parameters to be exported to the 
Journal in the Parameters to Export list box. The data table shows the calculations for the 
current position of the cursors. The values in the data table are exported to the journal on 
clicking the Add to Journal button.
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Spirometry

TV: Tidal Volume

IRV: Inspiratory Reserve Volume

ERV: Expiratory Reserve Volume

FEV1: Forced Expiratory Volume in one second. How much air can be exhaled in the first 
second of expiration

FEV3: Forced Expiratory Volume in three seconds. How much air can be exhaled in the first 
three seconds of expiration

VC: Vital Capacity

PEF: Peak Expiratory Flow

PIF: Peak Inspiratory Flow

TFR:Tidal Flow Rate.

IC: Inspiratory Capacity (IC) = TV + IRV

EC: Expiratory Capacity (EC) = TV + ERV

FRC: Functional Residual Capacity (FRC) = ERV + RV

TLV: Total Lung Capacity (TLC) = TV + RV + IRV + ERV
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ECG

Time at R: Time at the peak of the R-wave.

PR Interval: The time from the beginning of the P wave to the peak of the R wave.

P Duration: Time from the beginning to the end of the P-wave.

QRS Duration: Time from the beginning of the Q wave to the end of the S wave.

QT Interval: Time from the beginning of the Q wave to the end of the T wave.

ST Segment: Time from the end of the S wave to the beginning of the T wave.

T Duration: Time from the beginning to the end of the T wave.

TP Duration: Time from the beginning of the P wave to the end of the T wave.
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Blood Pressure

LVEDP pressure: Left Ventricular End Diastolic Pressure

Time at LVEDP: Time at LVEDP

Max Pressure: Maximum of the pressure, also the systolic value

Time at Max: Time at maximum pressure

Min. Pressure: Minimum pressure, also the diastolic value

Time at min: Time at minimum pressure

Notch Pressure: Pressure at the dichrotic notch

Time at Notch: Time at the dichrotic notch

Max dP/dT: Max slope

Time at Max dP/dT: Time at max slope

Min dP/dT: Minimum slope

Time at Min dP/dT: Time at minimum slope

Mean Pressure: Mean pressure

Contractility Index: (Maximum Slope)/(Pressure at Max Slope)

Systolic Duration: Time from LVEDP to minimum slope

Diastolic Duration: Time from the minimum slope to the next LVEDP
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Cycle Duration: Time between LVEDPs 

Relaxation Index: (Minimum Slope) / (Pressure at Minimum Slope)

Tau (Mirsky): Time for pressure to drop to half its value from the value at minimum slope

Peak Analysis

Max: Maximum amplitude

Min: Minimum amplitude

Max-Min: Maximum amplitude - Minimum amplitude

Mid Amp.: Amplitude at the midpoint of the middle threshold 

Low Width: Width of the peak as measures at the lower threshold

Mid Width: Width of the peak as measures at the middle threshold

Top Width: Width of the peak as measures at the upper threshold

Latency: Time from when the peak leaves the baseline to the peak

Rise Time: Time for the signal to travel from the lower threshold to the upper threshold

Fall Time: Time for the signal to travel from the upper threshold to the lower threshold

Leading Slope: Average slope of the signal as it travels from the lower threshold to the upper 
threshold
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Trailing Slope: Average slope of the signal as it travels from the upper threshold to the lower 
threshold

Max Slope: Maximum slope

Min Slope: Minimum slope

T @Max Slope: Time at maximum slope

T @Min Slope: Time at minimum slope

Copy, Export, 
and Print 
Analysis 
Window

To copy the view of data displayed in the Analysis window, use the Copy command in the 
Edit menu. The image can be pasted into any program (including the Journal) that supports the 
clipboard. To copy a Channel, click the Channel menu and choose the Copy Graph menu. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu.

Analyses of the Third Kind: Redisplayed Data
As covered in the display section of this manual, data is recorded only into the Main window. 

Main window displays are linear or in series, meaning that Y-value parameters are recorded with 
respect to time.

Data recorded in a linear manner can be redisplayed in a format that is different than the 
standard Y-T plot. Currently, DataTrax2 supports XY plots and FFT. A host of measurements, 
like the ones available in the Second Kind Analyses, can be made from each type of redis-
played data window.

XY Plot In an XY plot, the Y-values from one channel in the Main window are plotted against the Y-
values from another Main window channel. The resulting XY plot is dramatically different from a 
linear plot of data against time. 
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XY View 
Window 
Components

Selecting Channels To plot an XY graph, select the X-axis channel from the drop-down box in the top most plot. 
Then select the Y-axis channel from the drop-down box in the second plot. If required you can 
also select a marker channel, to highlight certain points of interest. 

Once the channels are selected, the XY plot will be displayed. All the data visible in the X and 
Y axis plots will be included in the XY plot. To select the region of data to be included in the XY-
Plot, select 2 Cursors from the toolbar and bracket the region of interest between the two 
cursors in the X-axis or the Y-axis channel. Next, select Zoom Between Cursors from the 
toolbar.

Functions List The functions selected in the Add Function list determine the calculations performed on the 
data points between the two cursors in the XY-PLot. The results of the selected calculations are 
displayed above the XY PLot .
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Table 
Functions 

These functions are available in the XY window.

General Y1: Value of Y-Axis Channel at Cursor 1.

Y2: Value of Y-Axis Channel at Cursor 2.

X1: Value of X-Axis Channel at Cursor 1.

X2: Value of X-Axis Channel at Cursor 2.

Y2-Y1: The difference in value of Y-Axis channel between the cursors.

X2-X1: The difference in value of X-Axis channel between the cursors.

MaxY: Maximum value of Y-Axis channel between the cursors.

MinY: Minimum value of Y-Axis channel between the cursors.

MeanY: Mean or Average value of Y-Axis channel between the cursors.

MaxY-MinY: Difference between the maximum and minimum values of Y-Axis channel between 
the cursors

MaxX: Maximum value of X-Axis channel between the cursors.

MinX: Minimum value of X-Axis channel between the cursors.

MeanX: Mean or Average value of X-Axis channel between the cursors.

MaxX-MinX: Difference between the maximum and minimum values of X-Axis channel 
between the cursors.

Length: Length of the line segment in the XY-plot between the two cursors.

Derivative dY1/dx: Slope of the XY-Plot at Cursor 1.

dY2/dx: Slope of the XY-Plot Cursor2.

Max dV/dt: Maximum slope of the XY-Plot between the two cursors.

Min dV/dt: Minimum slope of the XY-Plot between the two cursors.

Mean dV/dt: Mean slope of the XY-Plot between the two cursors. This is also the slope of the 
line of best fit for all the data points between the cursors.

Integral (Area) All the integral and area functions are calculated as integrals. 

Area wrt Ymin: The minimum value of the Y channel is taken as baseline and the area of all 
points between the two cursors is calculated with respect to this baseline. 

Area wrt Zero: Zero is taken as baseline and the area of all points between the two cursors is 
calculated with respect to this baseline. 

Area wrt Y1: The value of the Y channel at cursor1 is taken as baseline and the area of all 
points between the two cursors is calculated with respect to this baseline.

Area Loop: The area of the loop as defined by the position of two cursors is calculated.
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Channel Menu in 
the XY Window

Clicking on the Channel Menu button or right-clicking in the display 
area brings up the Channel menu. 

Add Ch. Data to Journal: Adds data from the selected channel to 
the Journal.

Add Title to Journal: Adds the function titles to the Journal.

Invert: Inverts the channel data.

Copy Graph: Copies the channel graph to the clipboard. This can be 
then pasted into the Journal or any other program.

Marker Channel The marker channel is used to mark specific points of interest in the XY-Plot. The marker 
channel is independent of the X and the Y channels, and should be setup in the Main window 
such that the peaks in the marker channel correspond to the points of interest.

When a marker channel is used, data from the XY plot is extracted at the specified points of 
interest and displayed in the Marker Data window. This data can be copied or exported by 
clicking on Options.

Copy, Export, 
and Print XY 
View Window

To copy the view of the data displayed in the XY window, use the Copy command in the Edit 
menu. The image can be pasted into any program (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the XY window or all the data, can be selected in the Print window

FFT FFT is short for Fast Fourier Transform, a mathematical operation that displays recorded data 
as the relative amplitudes of the frequency components that make up the recorded signal. FFT 
plots have Frequency on the X-axis and the Power (amplitude) contained in each frequency on 
the Y-axis. FFT is used to determine the relative strengths of frequency components in a raw 
signal. For example, in the EEG studies, the Alpha band is frequently mentioned. Alpha waves 
are EEG signals with frequencies between 8 and 13 Hz. If a FFT is performed on an EEG 
recording that has a high number of Alpha waves, the FFT will show a spike or a higher 
amplitude (Power) at the frequencies in the Alpha band. 

The DataTrax2 software can perform Fast Fourier Transforms on selected pieces of recorded 
data in the FFT window. The FFT window is called either from the Windows menu or by clicking 
the FFT icon on the toolbar at the top of the Main window. The selected data is moved to the 
Linear Display area in the FFT window where adjustments can be made which optimize the size 
of the FFT plot. 

To ensure problem-free operation of the FFT function, there are a couple of rules to keep in 
mind:

1 1. The mathematical underpinnings of digital sampling, which makes the DataTrax2 software work, 
begin with a criteria known as the Nyquist Sampling Theorem. Harry Nyquist showed that the sampling 
rate must be at least twice the highest frequency in the sample to reconstruct the original signal and 
capture its fundamental frequency. The converse of this rule is that the fastest frequency that can be 
reliably recorded is a half of the sampling rate. If a recording was made at 1000 samples per second, 
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the maximum frequency that could be recorded reliably would be 500Hz. If a recording was made at 100 
samples per second, the maximum frequency that could be recorded reliably would be 50Hz. When a 
FFT is performed on data recorded with DataTrax2, the program sets the X-axis to a scale from 0Hz 
(DC) to a frequency that is a half of the sampling rate. A region of the scale can be expanded by using 
the cursors and the functions of the Channel menu, but frequencies greater than half the sampling rate 
cannot be viewed.

2 To make an FFT work, the transform must operate on a specific number of data points. The number of 
data points used in the FFT is algorithm dependent. By default The Snap to Grid option is selected, 
which sets the second cursor to the location of the best selection of FFT data on the linear display 
section of the FFT window. If you have to select a different selection, DataTrax2 will fill in the remaining 
data points with zeros so the frequency content of the data that you did select will not be affected. 

As stated in the first rule that governs FFT functions, DataTrax2 sets the X-axis limits in the 
FFT window according to sample rate. Likewise, the number of data points used in the FFT 
calculation sets the resolution of the X-axis range. If more data points are used, the available 
Frequency Resolution will be greater. Frequency Resolution is set from the drop-down menu 
in the left hand margin of the FFT window. Resolution choices are limited to 100 Hz, 10 Hz, 1 Hz 
and 0.1 Hz. If the FFT cannot be displayed with the required frequency resolution, more data 
points need to be used to make the calculation.

Moving and 
Manipulating 
Data in the FFT 
Window

As with other analysis functions handled by the DataTrax2 program, it is necessary to select 
the data to be operated upon by the program. The Display Time controls are used to get the 
data of interest onto a single screen in the Main window. The selected data is moved to the FFT 
window by clicking the FFT icon on the DataTrax2 toolbar or by selecting FFT from the 
Windows menu.

Once the primary data set is moved to the FFT window, the Dual Cursors on the linear graph 
of the raw data (above the actual FFT display area) can be used to fine-tune the data selection. 
Only the data between the cursors in the linear graph is actually used in the calculation. The 
data displayed on the linear graph and available for the transform can be changed using the 
Display Time icons on the FFT window or the scroll bar under the linear graph. As mentioned, if 
Snap To Grid is selected, the DataTrax2 program selects the end point for the data selection.

The FFT plot of the selected data is displayed in the area below the linear graph of the raw 
data. The FFT display area has its own Display controls with the Zoom In, AutoScale and 
Zoom Out functions and set of 2 Cursors. These features can be used to expand or contract 
the area of the FFT graph between the cursors. This set of 2 Cursors also reports the values for 
the selected Table Functions listed above the FFT window. The values and the titles, which are 
listed in the Calculated Value Display area at the top of the window, can be copied to the 
Journal by using the functions in the channel menu for the FFT display area. 

FFT Window 
Components
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 Figure 5-8:FFT Window

Display Channel Located in the upper left of the channel display area, this drop-down box allows the user to 
select the channel to be used in the FFT plot.

FFT Functions 
List

The calculations to be performed on the region of the FFT plot between the 2 Cursors are 
selected from the Add Functions button on the top left of the FFT display area. The results of 
the selected calculations are displayed in the Calculated Value Display area at the top of the 
FFT window. 

Display Controls The FFT plot has display controls similar to the Main window such as Half Display Time, 
Zoom between Cursors and Double Display Time. The Y-axis can be scaled using the 
ZoomIn, AutoScale and ZoomOut buttons in the FFT area toolbar. The frequency resolution 
drop-down box allows setting the frequency resolution of the FFT from 10Hz to 0.01Hz.
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Table 
Functions 

These functions are available in the FFT window.

General Power1: Power at Cursor 1

Power2: Power at Cursor 2

Freq1: Frequency at Cursor 1

Freq2: Frequency at Cursor 2

P2-P1: Difference in power between the cursors

F2-F1: Difference in frequency between the cursors

Max power: Maximum power between the cursors

Min power: Minimum power between the cursors

Mean power: Mean power between the cursors

MaxP-MinP: (Maximum power - Minimum Power) between the cursors

Freq at Max power: Frequency at maximum power between the cursors

Freq at Min power: Frequency at minimum power between the cursors

Integral Power between Cursors: Total power between the cursors 

Channel Menu in 
the FFT Plot

Click the Channel menu to bring up a menu like the one in Figure 5-9 on page 73. 

Selecting Add Title to Journal sends the names of the 
analyses (calculations) being performed and displayed in the 
Calculated Value Display area at the top of the FFT window, 
to the Journal. Selecting Add Data to Journal sends the 
values for these calculations to the Journal. Selecting Copy 
Graph sends an image of the FFT window to the clipboard.

 Figure 5-9: FFT channel menu

Copy, Export, 
and Print FFT 
Windows

Use the Copy command in the Edit menu to copy the view of data displayed in the FFT 
window. This image can be pasted into any program, (including the Journal) that supports the 
clipboard. 

To export the data viewed, use the Export command in the File menu. Select the format of the 
exported file from the list at the bottom of the Export File window.

To print the data viewed, use the Print command in the File menu. The print range, which is 
either the selection in the FFT window or all the data, can be selected in the Print window.
5 Analysis 73



. .
 

Analyses of the Fourth Kind: Detected Data Conditions
DataTrax2 software can be used to identify Regions Of Interest (ROI) in recorded data. The 

identified data points can be sent to either the Journal or the Marks window, where they can be 
used to either build a report or be exported. While identifying data does not constitute an 
analysis per se, the detection of specific data always precedes analysis. For example, to 
measure changes in Left Ventricular End Diastolic Pressure (LVEDP) over time, the LVEDP 
points need to be located in the field of blood pressure data and the corresponding values need 
to be recorded. The statistical manipulation of the recorded LVEDP values is classified as 
analysis; but, the first critical step in the “analysis” was the extraction of the relevant data points 
or regions of interest from the complete data. The events (data points or regions of interest) that 
can be detected by the DataTrax2 program are classified into two categories: General and 
Specific.

General 
Events

General events can be located easily through the Find or the Auto Find dialog windows.

Find Dialog 
Window

The Find dialog window is accessed by selecting Find from the Tools menu. Data points of 
interest can be identified using stock commands from the Find dialog window. These commands 
can move cursors to: the Previous or Next Maximum; the Previous or Next Minimum; the 
Previous or Next, Pos or Neg threshold crossing; Data Above or Below a certain amplitude; 
data at a specific Mark with a particular string in a comment; data at an Old or New Cursor 
position; and more. The calculations to be performed on the selected data points or on the data 
between the points are chosen from the Table Functions list before the Find dialog window is 
opened. 

The first step in the Find function is the selection of the Cursor 1 Position from the box to the 
right of this label. The next step in the Find function is the selection of the Cursor 2 Position 
from the box to the right of this label. Once the source of the data is selected and the Find 
routine is completed, it can be saved by clicking the Save button on the Find dialog window. 
The named routine is saved in the Auto Find folder as an .iwxfind file. When the Find dialog 
window is open, saved routines can be recalled by clicking on the Load button.

Find Example As an example, the Find function could be used to determine the time (T2-T1) between two 
events. Occasionally, R waves in an ECG have significantly higher amplitudes than the other R 
waves in the same recording. The Find function could be used to measure the time between 
adjacent supranormal R waves. The process would include:

• Transferring the data of interest from the Main window to the Analysis window. 

• Selecting the calculations ( V1, V2, V2-V1) to be performed on the data from the Table Functions list. 

• Placing one of the 2 Cursors on a supranormal R wave on the left side of the Analysis window.

• Pulling down the Tools menu and selecting the Find function.

• Programming the cursor positions. To find the next supranormal R wave in the data, the Cursor 1 
Position is set equal to Old Cursor 1 (which is already on a supranormal R wave). The Cursor 2 Position 
is set to Data Above and the data channel is selected. The threshold amplitude, above which the Find 
function will stop, is entered into the box below the label Cursor 2 Position. Then the Find routine is 
saved.

• Clicking the Find button to place the cursors and to display the values for the selected Table Functions 
at the top of the Analysis window. 
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• Copying values and their headings to the Journal via the Add Title to Jrnl and Add Data to Jrnl 
functions in the Right-Click menu of the Analysis window.

Auto Find Dialog 
Window

The Auto Find dialog window (Figure 5-10 on page 75) is like the Find window. It is also 
accessible from the Tools menu and works only from the Analysis or ScopeView window. 
However, the Auto Find function can be programmed to find multiple data points with the same 
parameters within a data selection. The values at those points can be used for Second Kind 
Analyses and the results of these analyses can be written to the Journal automatically. 

The Auto Find function can find the same types of data points found with the Find function, 
like: Next Maximum, Previous Minimum, Data Above a given value, the next Mark containing 
a particular alpha-numeric string, and more. Like Find routines, Auto Find routines may be 
constructed from the various parameters available and saved in the Auto Find folder. For 
periodic functions, maximum values, and minimum values, DataTrax2 uses the threshold values 
set for Periodic data on the Functions page in the Preferences dialog window for the Main 
window. Just like other measurements of periodic data, the data must be scaled properly, which 
can be accomplished in most cases by clicking the AutoScale button in the Main window.

Auto Find 
Example

As an example, the Auto Find routine can be used to place cursors on all the R waves in an 
ECG record and to measure the period (T2-T1) of each beat. The easiest way to begin the Auto 
Find routine is to manually place the cursors on the two successive R waves at the beginning of 
the record. When selecting the commands to use in this routine, the user should ask 
themselves: “Where are the next two data points that are needed for measuring the next period 
(T2-T1)?” The answer is that the first data point in the next period is the second R wave from the 
preceding period, and the second R wave in the next period is the next maximum value or R 
wave in succession. Therefore, to make accurate measurements on the next period, the Auto 
Find window is programmed to set the Cursor 1 Position to be Old Cursor 2 and the Cursor 2 
Position to be the Next Max. 

 Figure 5-10: The Auto Find dialog window.
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After the number of repetitions specified or the specified end of the Auto Find routine is 
reached, the Auto Find routine can be saved by clicking Save on the dialog window. The named 
Auto Find routines are saved as .iwxfind files and can be called by clicking on the Load button 
in the dialog window.

Specific 
Events

The detection of Specific events within a recording requires the use of an algorithm to find the 
point or region of interest (ROI). The LVEDP, the R in an ECG, and the P wave in an ECG are 
good examples of Specific events. Detection of these data points requires a defined software 
routine that resides in the DataTrax2 program. The routines are accessible by selecting Auto 
Mark from the Tools menu and the name of the specific event from the Auto Mark drop-down 
menu. When the detection routine is run on the selected data, the software puts Marks on the 
data at the detected points. The automatic placement of Marks on the data accomplishes two 
things; first, it identifies the data points that need to be manipulated; second, it provides the 
user with visual cues to confirm that the software did the job of detecting the correct points. 
Based on the instructions given to DataTrax2, the detected data can be exported as text or 
loaded into a script. 

In DataTrax2, there are Auto Mark functions available to detect: the components of the ECG, 
the Blood Pressure and Peak Analysis.

ECG For example, if the Auto Mark detector is used to locate the components in an ECG, the ECG 
function is selected from the Auto Mark submenu on the Tools menu. A window known as the 
AutoMark ECG Dialog appears on the screen. It contains a display of the data to be used with 
the marking routine. In this window, selections must be made for the Data Channel that is the 
source of the recording being marked, the Maximum Heart Rate (BPM) in the data of interest, 
and the Start and Stop points for marking the data of interest.

The Start and Stop points could be the beginning and the end of the data file (Doc.), respec-
tively. They could also be any Mark on the data file. Since Marks can be placed on the data 
after the recording, it is possible to place and use Marks that are on the margins of the data of 
interest. To assist in R wave detection, a threshold level must be set on the data.

Finally, press Preview and close the AutoMark QRS Dialog window by clicking OK. Each R 
wave in the selected section of data will be marked with a Text Mark. These marks can be 
viewed and edited in the Marks window. The Marks window is organized so that the marks can 
be sorted by Time (ascending or descending), Channel, or by Content by clicking on the title of 
the column in the Marks table. Individual comments, or ranges of comments, may be selected or 
deselected using the SHIFT and CONTROL keys. Appropriate collections of selected comments 
can be exported or deleted.
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 Figure 5-11: ECG AutoMark Dialog

 Figure 5-12: ECG AutoMark Example
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Blood Pressure

 Figure 5-13:Blood Pressure Automark Dialog

 Figure 5-14: Blood Pressure Automark Example
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Peak Analysis

Analysis of the Fifth Kind: Things Not Possible with 1st, 2nd, 
3rd, or 4th Kinds of Analyses

Not Yet Implemented in DataTrax2:

It is impossible to include all of the possible analyses and plotting capabilities required for 
biological research in a single program. We provide, what we believe to be, useful tools for 
completing the most common kinds of analyses. For circumstances where the built-in analysis 
tools fall short of the user’s requirements, DataTrax2 has a Script function. A script is a 
program, written in any of the languages supported by DataTrax2, that can perform a series of 
calculations on selected data. Once created, a script can be placed in the Scripts folder located 
in the DataTrax2 folder. The script will then appear as a menu item in the DataTrax2 Scripting 
menu. When selected, the script takes the selected range of recorded data, saves the data in a 
format compatible with the scripting language, loads the scripting program, and then executes 
the script on the saved data. The scripting programs supported by DataTrax2 are listed below. 
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For example, we have created a script in Python, which operates on the R-R intervals of the 
ECG, which are detected by an Auto Mark function in the Tools menu. Then the R-R script 
computes and displays a tachogram, plots Delta R-R histograms and determines values for 
statistics, such as mean, mode, and standard deviation. 

Writing 
Scripts

DataTrax2 has a special folder called Scripts located in the DataTrax2 folder. Any scripting 
files or executables placed in this folder will be included in the Scripting menu when DataTrax2 
is launched.

Scripts can be run from the Main, Analysis, or ScopeView windows in the DataTrax2 
program. Different data is presented to the script depending on which window is used to call the 
script. 

The Default Export File Format, for exporting the data that the script will use, is set on the 
Advanced page of the Preferences dialog window. The default file format is .mat, or the Matlab 
File format. For information about the MatLab and DADiSP file formats, refer to the Export 
section of this manual.

Scripts in the Main 
Window  

When a script is run from the Main window, DataTrax2 saves the complete data file in the 
Scripts folder as either input.mat (Matlab) or inputXX.dat (DADiSP). In DADiSP, each block is 
numbered as it is saved XX, starting with 00. When DataTrax2 calls the script file, the Windows 
operating system opens the script file in the program associated with it. For example, a Python 
script should open in the Python program and a MatLab script will open in the MatLab program 
and so on. Scripts should be set up to open and analyze data files with the names as described. 

Scripts in the 
Analysis Window  

When a script is run from the Analysis window, DataTrax2 saves the data in the Analysis 
window display in the Scripts folder as either input.mat (Matlab) or input.dat (DADiSP). When 
DataTrax2 calls the script file, the Windows operating system opens the script file in the 
program associated with it. For example, a Python script should open in the Python program, 
and a MatLab script will open in the MatLab program and so on. Scripts should be set up to 
open and analyze data files with the names as described. 

Scripts in the 
ScopeView 
Window  

When a script is run from the ScopeView window, DataTrax2 saves the data in the 
ScopeView window display in the Scripts folder as either input.mat (Matlab) or input.dat 
(DADiSP). When DataTrax2 calls the script file, the Windows operating system opens the script 
file in the program associated with it. For example, a Python script should open in the Python 
program and a MatLab script will open in the MatLab program and so on. Scripts should be set 
up to open and analyze data files with the names as described. 
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Chapter 6: Input and Output 

Stimulator
The Stimulator page in the Preferences dialog box controls the Digital-to-Analog Converter 

or DAC of the WPI hardware. It can be reached by selecting Preferences from the Edit menu. 
The stimulator feature sends the DAC output to the outside world. Using controls described 
below, output protocols can be built from “square wave” components that are listed on the 
Simulator page of the Preferences dialog window. The available output range of the stimulator 
is ±5V for the WPI 214 and ±10V for WPI 118 and 3xx.

The WPI 118 has two DACs, while the 3xx has a DAC on each 
channel. Each DAC can be controlled independently. The stimu-
lator drop-down box (currently set to Stim1) allows selection of 
the stimulator to be setup. For devices with multiple stimulators, 
the import Settings button allows the user to copy settings from 
one stimulator to another. 

Six modes of output, Pulse, Trains, Constant (voltage), Step, 
Triangle and Ramp, can be selected using the mode drop-down 
box (currently set to Off). Triangle and Ramp protocols are 
available only on the WPI 3xx. 

The Bipolar checkbox allows the creation of bipolar pulses.

The stimulator can be set to fire when the recording is started by 
checking the Start Stimulator with Recording checkbox.

Time Resolution: The WPI 3xx has three time resolutions, 0.04ms, 0.4ms and 4 ms. The finer 
the time resolution the shorter the maximum time duration for each parameter. For example, at 
0.04msec Time Resolution the maximum delay is 600 ms. At 0.4ms this increases to six 
seconds, while at the 4msec resolution the maximum delay is 60 seconds.

The software configures itself depending on the hardware selected and will limit the available 
range of values for each parameter accordingly.

Toolbar Steps: This determines the minimum step increments that the stimulator toolbar will 
use when the up/down buttons on the toolbar are clicked. These are also the increments used 
by sequences for programming the stimulator. 
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Pulse 
Protocols

 Figure 6-1: The parameter boxes on the Stimulator page of the Preferences dialog window.

In order to understand how protocols are created, it is necessary to define the terms used on 
the Stimulator page of the Preferences dialog window:

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the first pulse. Delay is adjustable as follows:

WPI 118 (6500 ms), WPI Latrax 24 series:(600 ms, 6s or 60 s).

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preferences window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preferences window or the Stimu-
lator Control Panel, or automatically from a programmed sequence (more later).

Number of Pulses: The total number of pulses that can be sent from the stimulator output

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration .

Pulse Frequency: This is the number of programmed pulses that are delivered in one second 
period of time. The maximum frequency that can be set is dependent on the pulse duration. 
Remember that the period (P) is the inverse of the frequency (F), or P = 1/F.

Time Off: This is the interpulse duration, i.e. the amount of time between two consecutive 
pulses. Pulse Frequency is 1/(pulse width + Time Off).
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Holding Potential: This is a voltage between ±10V  that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyperpolarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing.”

Building Output 
Protocols in Pulse 
Mode

To record stimulus pulses like the examples that follow, the stimulator output of an WPI unit 
can be connected to one of its own BNC inputs. On the WPI 118, this is easily accomplished by 
using a BNC-BNC cable. However, the stimulator outputs of the WPI 214 unit consists of three 
color-coded banana jacks, so a Double Banana-BNC adapter or cable is needed to connect two 
of the banana jacks to one of the BNC inputs. To record positive pulses, connect the adapter to 
the positive (red) and ground (green) banana jacks; to record negative pulses, connect the 
adapter to the negative (black) and ground (green) banana jacks. Double-Banana adapters have 
a flag or bump on one side that indicates which side should be attached to the ground jack.

Note: Never connect both the positive (red) and the negative (black) banana outputs of a 214 unit to its 
own inputs, as this causes a short circuit that could damage the amplifier. These red and black outputs can 
be connected to other devices (nerve chambers, stimulating electrodes, and more), but not to its own 
inputs.

An Example of 
Continuous Pulses

1 To construct and record some examples of stimulus pulses, select Preferences from the Edit menu. On 
the Channel page of the Preferences dialog window set a channel that has a BNC input to record 
at 10,000 samples/second and display 0.5 seconds on the screen. Also select the Stim1 channel and 
set it to record the stimulator. (Figure 6-2 on page 83). 

 Figure 6-2: Channels page of the Preferences dialog window set for the pulse mode example.

2 Go to the Stimulator page of the Preferences dialog window; select Pulses from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 0 (for continuous)
Pulse Width 5ms
Pulse Frequency 100 Hz
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Holding Potential 0 V

These settings will create a protocol that delivers continuous square waves with 1V amplitude 
and 100Hz frequency. 

4 Press the Record button. The DAC will wait 100 milliseconds (the Delay value entered) and begin to 
deliver 5ms pulses at the rate of 100 pulses per second. Each pulse will be 1V high. These pulse 
parameters can be adjusted in any way with one exception, the pulse width cannot be longer than the 
inverse of the frequency (or the period). In this example, the 100Hz square wave delivers 100 events or 
pulses every second. Therefore, each single event or pulse must occur in 1/100th of a second, which is 
a 10ms period. In this example, the pulse width cannot be longer than the period of 10ms or the pulse 
will overlap the next pulse. The percentage of the period occupied by the pulse width is known as the 
duty cycle and refers to the amount of time the output amplifiers are active.

An Example of a 
Burst of Pulses

Use the settings listed for the example of continuous pulses to produce a short burst of pulses, 
with one exception. Set the Number of Pulses to a number other than zero. If the number 10 is 
entered in this box, the output from the DAC would wait the 100 millisecond delay from the Start 
signal, deliver its 100Hz square wave of 5ms by 1V pulses as before, but stop when 10 pulses 
had been delivered. A graphical representation of the two examples above is pictured in Figure 
6-3 on page 84.

 Figure 6-3: Continuous (top) and burst (bottom) of pulses that are the same amplitude, width, and frequency.

Train 
Protocol

A train of pulses is more properly called a burst of pulses. Trains contain a specified Number 
of Pulses, which occur a specified number of times (Number of Trains) at regular intervals 
(InterTrain Duration). The train protocol is an extension of the pulse protocol so it is essential 
to be familiar with the pulse protocol to use the train protocol. 

Continuous output

Burst or Train output
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 Figure 6-4: The parameter boxes on the Stimulator page for Train mode.

The terms used on the Stimulator page of the Preferences dialog window for configuring 
trains of pulses, include:

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button and the first pulse. Delay is adjustable as follows:

WPI 214 (650ms), WPI 118 (6500 ms), WPI 3xx:(600 ms, 6s or 60 s)

Amplitude: This is the height or voltage of the pulse or wave being generated. The amplitude 
programmed from the Preferences window will be the same for all pulses leaving the stimulus 
output unless the amplitude is changed manually from the Preferences window or the Stimu-
lator Control Panel, or automatically from a programmed sequence (more later)

Number of Pulses: The total number of pulses that can be sent from the stimulator output

Pulse Width: The pulse is the basic unit of an output protocol and it has two basic dimen-
sions, amplitude, as described above, and length. The length of the pulse is also called pulse 
width or pulse duration

Pulse Frequency: This is the number of programmed pulses that are delivered in a one 
second period of time. The maximum frequency that can be set is dependent on the pulse 
duration. Remember that the period (P) is the inverse of the frequency (F), or P = 1/F

Time Off: This is the interpulse duration, i.e. the amount of time between two consecutive 
pulses. Pulse Frequency is 1/(pulse width + Time Off)

Number of Trains: Number of Trains 

InterTrain Duration: The length of time between successive trains or bursts
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Holding Potential: This is a voltage between ±10V that can be programmed to shift the 
resting voltage of an excitable tissue (like a nerve). It is also known as a holding voltage 
because it can be used to hyper polarize the membrane potential of an excitable tissue and 
prevent it from depolarizing or “firing.”

Building Output 
Protocols in Train 
Mode

Connect the stimulus outputs to one of its own BNC inputs as described in the Building 
Output Protocols in Pulse Mode section of this chapter.

Note: Never connect both the positive (red) and the negative (black) banana outputs of a 214 unit to its 
own inputs, as this causes a short circuit that could damage the amplifier. These red and black outputs can 
be connected to other devices (nerve chambers, stimulating electrodes, and more), but not to its own 
inputs.

In many applications, more than one burst or train of pulses must be delivered. Before the 
parameters of the trains or bursts are specified, the dimensions of the pulses that will fill the 
bursts must be selected. After the pulse is designed, the frequency, duration, and number of 
trains can be programmed.

An Example of 
Pulse Trains

1 To construct and record an example of pulse trains, select Preferences from the Edit menu. On the 
Channels page of the Preferences dialog window set a channel that has a BNC input to record at 
10,000 samples/second and display 0.5 second on the screen (Figure 6-2 on page 83). 

2 Go to the Stimulator page of the Preferences dialog window; select Trains from the box in 
the upper left corner of the page.

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 100msec (an arbitrary value)
Amplitude 1V 
Number of Pulses 10 (10 pulses at 100 Hz = 0.1 sec)
Pulse Width 5ms
Pulse Frequency 100 Hz
Number of Trains 25
InterTrain Duration 900ms

These settings will create a protocol that delivers: a train of pulses every second; 10 pulses in 
each train with a frequency of 100 Hz; and, all pulses with an amplitude of 1V and a width of 
5msec. Since a train occurs every second and is 100msec long, the time between trains, the 
InterTrain Duration, needs to be 900msec.

4 Press the Record button. The DAC will wait 100 milliseconds (the delay value entered) and begin to 
deliver ten 5ms pulses in a tenth of second. Each pulse will be 1V high. After 900 milliseconds, a 
second burst of ten pulses with the same parameters will occur. These bursts will appear in this manner 
until a total of 25 bursts have occurred. 

5 If you only wanted the train or burst to repeat four times, the number four should be entered in the 
Number of Trains box. The completed output protocol should look something like Figure 6-5 on page 
87.
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 Figure 6-5: Burst of pulses separated by Inter Train Durations.

Constant 
Voltage 
Protocol

Selecting the Constant (voltage) option on the Stimulator page of the Preferences dialog 
window disables the entry boxes for all stimulus parameters except Amplitude and Delay. When 
the Record button is clicked, the voltage set on the Stimulator page is delivered to the low 
voltage output of the WPI unit. The voltage output terminates when the recording is stopped.

Step Mode Step mode is used almost exclusively for voltage clamp protocols. In Step mode, the 
amplitude of stimulator output can be increased or decreased in a step-wise manner, and the 
user can specify the following parameters: Delay, Start Amplitude, Stop Amplitude, Number 
of Steps, Step Width, Time off (or Inter Step Width), Repeat Count, Interprotocol Duration 
and Holding Potential

 Figure 6-6: The parameter boxes on the Stimulator page set for Step mode.

Building Output 
Protocols in Step 
Mode

The amplitude of each individual step in the protocol is determined by the DataTrax2 program 
with the Starting and Ending Amplitudes and the Number of Steps entered on the Stimulator 
page. The equation used to do this calculation is: 

(Start Amplitude - End Amplitude) = Voltage Increment
 Number of Steps
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If the user knows the voltage increment needed at each step, the equation can be transposed 
to solve for the Number of Steps required in the protocol and this value can be entered on the 
Stimulator page:

(Start Amplitude - End Amplitude) = Number of Steps.
Voltage Increment

Likewise, if the user knows the previous amplitude and the voltage increment, the succeeding 
amplitude can be calculated:

Previous Amplitude + Voltage Increment = Succeeding Amplitude

With the starting, ending and incremental voltages set through Preferences, the voltage will 
change in a step wise manner until the ending voltage is reached. The length of the protocol is 
determined by the Step Width and the time between steps, the Time Off.

Repeat Count: The number of times the above step protocol will repeat

Interprotocol duration: The duration of time between the termination of one protocol and the 
initiation of the next protocol

An Example of 
Voltage Steps

1 To construct and record an example of pulses in Step mode, select Preferences from the Edit menu. 
On the Channels page of the Preferences dialog window set a channel that has a BNC input to 
record at 10,000 samples/second and display 0.5 second on the screen (Figure 6-2 on page 83). 

2 Go to the Stimulator page of the Preferences dialog window; select Step from the box in the upper left 
corner of the page. 

3 Enter the following values into the appropriate boxes on the Stimulator page:

Delay 0
Starting Amplitude  -1V
Ending Amplitude +1V
Number of Steps 8
Step Width 100 ms
Time Off 0
Repeat Count 1
Interprotocol duration 0
Holding Potential 0

4 These settings will create a wave form that starts at -1 Volt and climbs to +1 Volt in eight steps, each 
step has a voltage increment of 0.25V and 100ms wide.

5 Press the Start button. The resulting wave would be similar to the step-wise elevation of 
output amplitude seen in Figure 6-7 on page 88. 

 Figure 6-7: An example of a continuous step protocol.
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6 To create a step protocol where the voltage returns to a baseline value between steps, alter 
the Time Off to a number greater than zero. The resulting wave would be similar to that seen 
in Figure 6-8 on page 89.

 Figure 6-8: An example of a step protocol punctuated by returns to baseline between steps.

7 A Constant voltage protocol can be combined with the Step protocol to have the voltage return to a 
different baseline after the completion of the step sequence. For example, setting the Holding Potential 
in the sample step protocol to 500mV would cause the output amplitude of the stimulator to return to 
500mV at the end of the step sequence. Subsequent firings of the protocol would begin from the new 
baseline of 500mV, drop to the Start Amplitude in the example (-1V), step to the End Amplitude (+1V), 
and then return to the Holding Potential of 500mV.

Ramp 
Protocol

 Figure 6-9: The parameter boxes on the Stimulator page set for Ramp mode

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the beginning of the ramp
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Delay Amplitude: The amplitude during the delay period. Only available on the WPI 3xx

Start Amplitude: The starting amplitude of the ramp

Stop Amplitude: The ending amplitude of the ramp

Rise Time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Ramps: Number of Ramps 

Interprotocol Duration: Time between ramps

Holding potential: The amplitude during the interprotocol duration

Triangle 
Protocol

 Figure 6-10: The parameter boxes on the Stimulator page set for Triangle mode

Delay: This is the time between the beginning of the recording, at the clicking of the Record 
button, and the beginning of the triangles

Delay Amplitude: The amplitude during the delay period. Only available on the WPI 3xx

Start Amplitude: The starting amplitude of the triangle

Stop Amplitude: The ending amplitude of the triangle

Rise Time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Triangles: Number of Triangles 

Interprotocol Duration: Time between triangles
6 Input and Output 90



Holding potential: The amplitude during the interprotocol duration. Should be set to Start 
Amplitude if not being used

The 
Stimulator 
Panel 

Selecting the Stimulator Panel item in the View menu (Figure 6-11 on page 91) will place a 
Stimulator Control Panel (Figure 6-12 on page 91) on the Main window.

The Stimulator Panel can be used to create a new protocol or change 
the parameters for an existing protocol

Each stimulator mode has a unique toolbar as shown below.

 Figure 6-11: The View menu.

Pulse Mode

 Figure 6-12: The Stimulator Pulse Control Panel.

Amp: Amplitude of the stimulus pulse in Volts

#pulses: Number of Pulses

Width(ms): Width of the pulse in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

HP: Holding potential

Apply: applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Train Mode

 Figure 6-13: The Stimulator Train Control Panel.

Amp: Amplitude of the stimulus pulse in Volts

#p: Number of Pulses

W(ms): Width of the pulse in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

#R: Number of Trains (or Repeat Count)

IP Dur: InterTrain(or inter protocol) duration

HP: Holding Potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output
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Step Mode

 Figure 6-14: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude.

#steps: Number of Steps

W(ms): Width of the step in milliseconds (ms)

F(Hz): Frequency of stimulation in Hertz (Hz)

#R: Repeat Count

IP Dur: Inter protocol duration

HP: Holding Potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output 

Constant Mode

 Figure 6-15: The Stimulator Constant Control Panel.

Amplitude: Amplitude.

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will set the amplitude at the output.

Ramp Mode

 Figure 6-16: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude

Rise time: The time taken to go from the Start Amplitude to the Stop Amplitude

Num Ramps: Number of Ramps

IR: Time between Ramps

HP: Holding potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Triangle Mode

 Figure 6-17: The Stimulator Step Control Panel.

A1: Starting Amplitude

A2: Stopping Amplitude
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Rise time: The time taken to go from the Start Amplitude to the Stop Amplitude

# Triangles: Number of Triangles

IR: Time between Triangles

HP: Holding potential

Apply: Applies any changes to the stimulus protocol made through the Stimulator Toolbar. 
Clicking Apply while recording will send a stimulus pulse from the output

Note: The Stimulator preferences dialog will draw whatever protocol you specify. Be sure to examine the 
output representation carefully before closing the dialog to confirm that this is in fact the output that you 
want.

Stimulator 
Display

On WPI 214/118/3xx, the stimulator output can be displayed as a channel in the Main window. 

Stimulus 
Protocols 
Built with the 
Sequence 
Builder

Experiments are often designed to record the response of a cell (or a tissue) to progressively 
larger or more frequent stimuli. In these cases, parameters of the stimulus are changed before 
each recording of the cell’s response to the next stimulus. The Sequence Builder, a page in the 
Preferences dialog window, can be used to automatically change parameters of the stimuli 
released from the DAC. 

For example, excitable tissues like nerves and muscles are composed of multiple fibers, each 
with a different diameter, conduction velocity and threshold. Fibers with higher thresholds 
require a larger stimuli to evoke their action potentials. Increasing the amplitude of the stimulus 
sent to the excitable tissue will cause more fibers in the tissue to fire. This is known as 
recruitment and is measured as an increase in the amplitude of the tissue’s compound action 
potential. 

In Scope mode, the Sequence Builder and other pages (Channels, Stimulator) in the 
Preferences dialog window can be used to record each response of the excitable tissue to a 
stimulus and automatically increase the amplitude of the stimulus between each trial.

Channels Page To construct an example of an Sequence designed to control the DAC and to record in Scope 
mode, select Preferences from the Edit menu. On the Channel page of the Preferences dialog 
window set:

Acquisition Mode Scope: Multiple
Number of Sweeps 10
Delay Between Sweeps 2
Start User
Stop Timed: 0.03 sec
Sampling Speed 20000
Display Time 0.030 sec
Select A1  Raw Channel 1: set Mode to BNC
Deselect A2-A4 i.e. raw channels 2, 3 and 4
Select S1  stim 1: Set Mode to Record.
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 Figure 6-18: Channels page of the Preferences dialog window set for testing an Output Sequence.

Stimulator Page

 Figure 6-19: Stimulator page of the Preferences dialog window set for testing an Output Sequence.
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On the Stimulator page, select Pulses as the stimulating mode and set the parameters.

• Toolbar Steps

Freq (Hz) = 1; Amp (V) = 0.05; Time (ms) = 0.1.

• Initial Parameters

Delay 5 ms

Amplitude 0.25 V

Number of Pulses 1

Pulse Width 0.1 s

Time Off 0.1 s

Holding Voltage 0 V

Sequence Page

 Figure 6-20: Output sequences page of the Preferences dialog window.

1 On the Sequences page, add a CAPRecruit sequence to the list of current sequences. Type the name 
CAPRecruit in the Edit box next to the Current Sequence Label, and click the New button.

2 Select the state titled Inc Pulse Amplitude under Stim 1 from the list of states on the left side of the 
page. 

3 Click on the button Add State to Sequence to add the state to the CAPRecruit sequence. 

4 Click OK at the bottom of the page.
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